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 Project planning and control can be influenced by several existing factors such as 
resources, natural conditions, material availability, and other factors. This study 
aims to determine the optimal time and cost of project completion after additional 
working hours (overtime) using the time cost trade off method which emphasizes 
critical path work. This method is done by adding working hours (overtime) on 
critical path work for 2 hours, 4 hours and 6 hours. The scheduling methodology 
used is assisted by Microsoft Project 2016 to find the critical path then crashing is 
carried out, using an alternative to accelerating the addition of working hours 
(overtime). Based on the results of the analysis of acceleration of construction time 
and costs with additional working hours (overtime) using the time cost trade off 
method in the residential house development project at Jalan Salak No. 70 is 233 
days in normal time with a total cost of Rp. 3,983,500,000. The optimum time and 
cost due to the addition of 2 hours of working hours is 231 working days, with an 
additional fee of Rp. 3,983,873,500. For the addition of 4 hours of overtime work is 
230 working days with an additional fee of Rp. Rp. 3,986,385,375, while an 
additional 6 hours of overtime is 229 working days with an additional fee of Rp. Rp. 
3,986,298,790. 
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Abstrak 

Perencanaan dan pengendalian proyek dapat dipengaruhi oleh beberapa faktor yang ada seperti 
sumber daya, kondisi alam, ketersediaan material, dan faktor lainnya. Penelitian ini bertujuan untuk 
menghitung dan mengetahui waktu dan biaya optimal akibat dari penambahan jam kerja (lembur) 
dengan menggunakan metode time cost trade off yang ditekankan pada pekerjaan lintasan kritis atau 
pekerjaan darurat. Metode ini dilakukan dengan menambah jam kerja (lembur) pada pekerjaan lintasan 
kritis selama 2 jam, 4 jam dan 6 jam. Metodologi penjadwalan yang digunakan dibantu dengan Microsoft 
Project 2016 untuk mencari jalur kritis kemudian dilakukan crashing, menggunakan alternatif 
percepatan penambahan jam kerja (lembur). Berdasarkan hasil analisis percepatan waktu dan biaya 
konstruksi dengan penambahan jam kerja (lembur) menggunakan metode time cost trade off pada 
proyek pembangunan rumah tinggal Jalan Salak No. 70 adalah 233 hari dalam waktu normal dengan 
total biaya sebesar Rp. 3.983.500.000. Waktu dan biaya optimum akibat penambahan jam kerja 
sebanyak 2 jam adalah 231 hari kerja, dengan penambahan biaya menjadi sebesar Rp. 3.983.873.500. 
Untuk penambahan jam kerja lembur 4  jam adalah 230 hari kerja dengan penambahan biaya menjadi 
Rp. Rp. 3.986.385.375, sementara untuk penambahan 6 jam kerja lembur adalah 229 hari kerja dengan 
penambahan biaya menjadi Rp. Rp. 3.986.298.790. 
Kata kunci: Waktu, Biaya, Tenaga Kerja, Jam Lembur, Metode Time Cost Trade Off 
 
1. PENDAHULUAN 

Rumah merupakan sebuah bangunan, tempat manusia tinggal dan melangsungkan 
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kehidupannya. Disamping itu, rumah juga merupakan tempat berlangsungnya proses sosialisasi 
pada saat seorang individu diperkenalkan kepada norma dan adat kebiasaan yang berlaku di dalam 
suatu masyarakat. Jadi setiap perumahan memiliki sistem nilai yang berlaku bagi warganya. Sistem 
nilai tersebut berbeda antara satu perumahan dengan perumahan yang lain, tergantung pada daerah 
ataupun keadaan masyarakat setempat [1]. Rumah adalah bangunan yang berfungsi sebagai tempat 
tinggal atau hunian dan sarana pembinaan keluarga [2]. 

Waktu dan biaya memiliki dampak yang signifikan pada keberhasilan atau kegagalan suatu 
proyek [3]. Evaluasi kesuksesan suatu proyek umumnya didasarkan pada sejauh mana proyek dapat 
diselesaikan dalam waktu yang singkat dan dengan biaya yang minimal, tanpa mengorbankan 
kualitas hasil pekerjaan. Untuk mencapai hal ini, pengelolaan proyek yang terstruktur sangat 
diperlukan. Ini membantu memastikan bahwa pelaksanaan proyek berjalan sesuai dengan kontrak 
atau bahkan lebih cepat, yang pada gilirannya dapat menghasilkan keuntungan dengan menghindari 
denda yang mungkin dikenakan karena keterlambatan penyelesaian proyek. Bahwa mempercepat 
waktu penyelesaian proyek adalah suatu usaha menyelesaikan proyek lebih awal dari waktu 
penyelesaian dalam keadaan normal. Ada kalanya jadwal proyek harus dipercepat dengan berbagai 
pertimbangan dari pemilik proyek. Proses mempercepat kurun waktu tersebut disebut crash 
program [4]. 

Dari data Proyek Pembangunan Rumah Tinggal Jalan Salak No. 70, Proyek dibangun dari 
tanggal 12 Desember 2022 sampai dengan 8 September 2023 dalam kurun waktu 38 minggu atau 
233 hari kalender sesuai dengan Schedule Kontrak (Perjanjian Kerja). Dan persentasi progress 
realisasi saat ini yang sedang berjalan di Minggu ke 22 (8-14 mei 2023) mencapai 45,008%, dengan 
target 49,1518%, deviasi minus -4,2510% (mengalami keterlambatan). Sesuai data progres 
pekerjaan tersebut telah menghabiskan Anggaran sebesar Rp. 1.800.320.000 (satu milyar delapan 
ratus juta tiga ratus dua puluh ribu rupiah), sedangkan untuk Anggaran Tenaga Kerja 31 orang 
sampai dengan progres Minggu ke-22 (8-14 mei 2023/154 hari kalender) sebesar Rp. 450.080.000. 
Dari gambaran data proyek rumah tinggal tersebut antara durasi waktu dan biaya belum optimal 
dalam penyelesaian proyek rumah tinggal tersebut. Dengan latar belakang permasalahan-
permasalahan di atas maka peneliti melakukan penelitian dengan judul “Analisis Percepatan Waktu 
dan Biaya Konstruksi  dengan Penambahan Jam Kerja (Lembur) Menggunakan Metode Time Cost 
Trade Off”. 

Sebelum melakukan penelitian ini penulis telah membaca dan mempelajari beberapa artikel, 
jurnal serta tugas akhir yang berkaitan dengan penelitian ini menggunakan metode Time Cost Trade 
Off. Adapun beberapa tinjauan sejenis oleh Laras Titi Nawang Wulan, dkk. (2020) yang berjudul 
“Evaluasi Optimalisasi Waktu dan Biaya dengan Penambahan Jam Kerja (Lembur) Menggunakan 
Metode Time Cost Trade Off. (Studi Kasus Proyek Peningkatan Jalan Kaligangsa Wetan – Randusanga 
Wetan). Hasil penelitian didapat waktu normal pada proyek yaitu 45 hari dengan total biaya sebesar 
Rp. 1.482.125.000 waktu dan biaya optimum akibat penambahan jam kerjalembur 1 jam didapatkan 
durasi proyek 38 hari dengan total biaya sebesar Rp. 1.210.527.713. Penelitian lain oleh Saptino 
Saputra Sinaga, dkk.  (2019) Penelitian ini berjudul “Analisis Time Cost Trade Off Dengan 
Penambahan Jam Kerja Untuk Percepatan Proyek Konstruksi. (Studi Kasus Proyek Pembangun 
Gedung Rumah Sakit Umum Type-C Medan Labuhan). Dari hasil penelitian durasi awal proyek adalah 
sebesar 414 hari kerja dengan nilai kontrak sebesar Rp. 92.752.574.264 Waktu dan biaya proyek 
yang diadapatkan akibat lembur 2 jam adalah dapat dipercepat sebesar 91 hari dengan penambahan 
biaya menjadi Rp 99.010.213.006. Sementara untuk lembur 3 jam waktu yang dapat dipercepat 
adalah 109 hari dengan biaya tambahan menjadi Rp. 10.557.420.403. 

 
Proyek Konstruksi 

Proyek konstruksi adalah cara/metode dalam mencapai suatu hasil dalam bentuk 
bangunan/infrastruktur yang dibatasi oleh waktu dengan menggunakan sumber daya yang ada 
secara efektif melalui kegiatan perencanaan (planning),     pengorganisasian (organizing), pelaksanaan 
(actuating) dan pengawasan (controlling) [5]. Proyek konstruksi adalah usaha kolaboratif yang 
memerlukan koordinasi yang baik antara berbagai pihak yang terlibat, termasuk pemilik proyek, 
kontraktor, arsitek, insinyur, dan pekerja konstruksi [6], [7]. Keberhasilan proyek konstruksi 
seringkali diukur oleh sejauh mana proyek dapat diselesaikan sesuai dengan rencana awal, dalam 
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batas biaya yang ditentukan, dan memenuhi standar kualitas yang diharapkan. 
 
Manajemen Proyek 

Proyek adalah suatu upaya atau aktivitas yang telah diorganisasikan untuk mencapai tujuan, 
sasaran, serta harapan-harapan penting dengan menggunakan anggaran dana juga sumber daya 
yang ada, yang harus diselesaikan dalam jangka waktu tertentu [8]. Manajemen proyek adalah 
proses penerapan fungsi-fungsi manajemen (perencanaan, pelaksanaan dan penerapan) secara 
sistematis pada suatu proyek dengan mengunakan sumber daya yang ada secara efektif dan efsien 
agar tercapai tujuan proyek yang optimal [9]. Manajemen dalam pelaksanaan konstruksi dilakukan 
dengan perencanaan dan penjadwalan, yaitu proses yang mencoba meletakkan dasar tujuan dan 
dasar sasaran termasuk menyiapkan segala sumber daya untuk mencapai tujuan dan sasaran 
tersebut. Dimana tujuan dalam pelaksanaan konstruksi adalah untuk menyelesaikan pekerjaan dan 
mendapat keuntungan dari total biaya yang dikeluarkan. Sedangkan sasaran dalam pelaksanaan 
konstruksi adalah pengembangan usaha dan peningkatan produktivitas [10]. 

 
Pengendalian Proyek 

Pengendalian merupakan usaha yang sistematis untuk menentukan standar yang sesuai 
sasaran perencanaan, merancang suatu informasi, membandingkan antara pelaksanaan dengan 
rencana, menganalisis kemungkinan adanya penyimpangan antara pelaksanaan dengan rencana, 
kemudian mengambil tindakan pembetulan yang diperlukan agar sumber daya yang digunakan 
menjadi efektif dan efisien dalam rangka mencapai sasaran dan tujuan [11]. Untuk mencapai hal 
tersebut perlu adanya bentuk-bentuk seperti berikut: a) Supervisi: melakukan serangkaian tindakan 
koordinasi pengawasan dalam batas wewenang dan tanggung jawab menurut prosedur organisasi 
yang telah ditetapkan dengan tujuan agar operasional dapat dilakukan secara bersama-sama oleh 
semua personel dengan kendali pengawas, b) Inspeksi: melakukan pemeriksaan terhadap hasil 
pekerjaan dengan tujuan menjamin spesifikasi mutu dan produk sesuai dengan yang direncanakan, 
c) Tindakan koreksi: melakukan perubahan dan perbaikan terhadap rencana yang telah ditetapkan 
agar dapat disesuaikan dengan kondisi pelaksanaan [11]. 

 
Penjadwalan Proyek (Time Schedule) 

 Penjadwalan proyek merupakan hasil perencanaan yang memberikan tentang penjadwalan 
yang sudah ditentukan dengan berbagai aktvitas [12], [13]. Demi kemajuan proyek maka dibutuhkan 
sumber daya yang meliputi biaya, peralatan, tenaga kerja, dan material yang sudah direncanakan 
dalam durasi waktu untuk penyelesaian proyek [14]. Menurut (Santosa, 2008) lingkup pekerjaan 
selama proses dari perencanaan dan pengendalian proyek adalah: a) Sebelum proyek mulai. Sebuah 
proses rencana dipersiapkan untuk menentukan tujuan proyek, tugas-tugas yang akan dikerjakan, 
jadwal dan anggaran; b) Selama proyek rencana yang telah dibuta dibandingkan dengan performasi, 
waktu dan biaya yang sebenarnya tejadi (actual); c) Jika ada perbedaan antara yang direncanakan 
dan yang akan terjadi sebenarnya, tindakan koreksi perlu dilakukan dan estimasi biaya dan waktu 
bisa diperbaharui [15] 

 
Metode Time Cost Trade Off (TCTO) 

Salah satu alternatif yang dapat dipergunakan untuk melaksanakan percepatan proyek adalah 
dengan menggunakan kerja lembur. Salah satu metoda yang dapat digunakan untuk menganalisis 
pengaruh percepatan proyek terhadap biaya yang harus dikeluarkan adalah dengan analisis 
pertukaran biaya dan waktu (Time Cost Trade Off). Time Cost Trade Off (TCTO) ialah konfersi jadwal 
untuk mendapatkan hasil yang lebih menguntungkan dari segi waktu, biaya serta pendapatan [15]. 
Dalam TCTO akan dapat diketahui/dihitung percepatan yang paling maksimum dengan biaya yang 
paling minimum. Tujuannya ialah untuk memanfaatkan proyek dengan durasi yang dapat diterima 
dan meminimaliskan biaya total proyek. Pengurangan durasi proyek dilakukan dengan memilih 
aktivitas tertentu dengan jalur kritis [12], [13]. Dalam analisis metode TCTO ini dengan berubahnya 
waktu penyelesaian proyek hingga berganti pula biaya yang hendak dikeluarkan. Penerapan 
metode TCTO dapat sangat membantu untuk menentukan waktu optimum dengan biaya yang efisien 
[16]. Kemudian dapat juga mengetahui pertukaran biaya dan waktu sehingga dapat merencanakan 
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solusi yang terbaik apabila proyek melakukan percepatan dengan meminimalkan penambahan 
biaya. 

 
Tambahan Biaya Pekerja (Lembur) 

Dengan diadakannya penambahan jam kerja (lembur), tentu akan menambah biaya untuk 
pembangunan sebuah konstruksi dari semula biaya normal tanaga kerja [17]. Berdasarkan 
Keputusan Menteri Tenaga Kerja dan Transmigrasi Republik Indonesia Nomor KEP. 
102/MEN/VI/2004 menyatakan upah penambahan tenaga kerja, untuk setiap penambahan satu 
jam kerja pertama, pekerja mendapatakan tambahan upah 1,5 kali upah perjam waktu nomal dan 
untuk penambahan jam kerja berikutnya pekerja akan mendapatkan 2 kali upah perjam waktu 
normal [18]. 

 

Tabel 1. Nilai Koefisien Penurunan Produktivitas Crash Duration 
 

Jam Lembur Penurunan Indeks Produktivitas Prestasi Kerja 
1jam 0,1 90 
2jam 0,2 80 
3jam 0,3 70 

 
Adapun perhitungan untuk biaya lembur pekerja dapat dirumuskan sebagai berikut, yaitu: 
a. Crash Duration 

1) Menghitung produktifitas harian 

Prod. Harian =
Volume pekerjaan 

Durasi Normal
 

2) Menghitung Produktifitas per jam 

Prod. Per Jam =
Produktifitas Harian 

Jam Kerja Normal Harian
 

Dimana: Jam kerja normal perhari adalah 8 jam per hari 
3) Menghitung produktifitas lembur 

Prod. Harian =Jam Kerja Lembur x Koef. Prod. Lembur x Prod. Per Jam 
Dimana: Jam kerja lembur per hari = 2 jam, 4 jam, 6 jam. Koefisien produktifitas = 80%, 60%, 
40% 

4) Menghitung produktifitas harian setelah dilakukan crash 
Prod. Harian + Produksi Lembur 

5) Menghitung crash duration 

𝐶𝑟𝑎𝑠ℎ 𝐷𝑢𝑟𝑎𝑡𝑖𝑜𝑛 =
Volume pekerjaan 

Prod. Harian Setelah Crash
 

b. Crash Cost 
1)  Menghitung upah kerja lembur per hari, untuk:  

 2jam = (1,5 𝑥 upah sejam normal) + (2𝑥 upah sejam normal)  
 4jam = (1,5 𝑥 upah sejam normal) + (3𝑥 (2 𝑥 upah sejam normal)  
 6jam = (1,5 𝑥 upah sejam normal) + (5𝑥 (2 𝑥 upah sejam normal) 

2)  Menghitung crash cost tenaga kerja per hari 
                  𝐶𝑟𝑎𝑠ℎ 𝑐𝑜𝑠𝑡 tenaga kerja per hari = upah harian + upah kerja lembur per hari 

3)  Menghitung crash cost total 
𝐶𝑟𝑎𝑠ℎ 𝑐𝑜𝑠𝑡 total = 𝑐𝑟𝑎𝑠ℎ 𝑐𝑜𝑠𝑡 per hari x 𝑐𝑟𝑎𝑠ℎ 𝑑𝑢𝑟𝑎𝑡𝑖𝑜𝑛 

c. Cost Slope 
Cost slope merupakan penambahan biaya untuk mempercepat suatu aktifitas per satuan waktu. 
Cost slope dapat dihitung dengan menggunakan rumus: 

Cost Slope =
Crash Cost 

Normal Duration –  Crash Duration
 

d. Analisis Waktu dan Biaya 
Dalam penelitian ini fokus utama perhitungan hanya biaya langsung proyek saja. Adapun 
Langkah-langkah dalam perhitunganan analisa waktu dan biaya sebagai berikut: 
1) Menghitung tambahan biaya dan kumulatif tambahan biaya  

Tambahan biaya = 𝐶𝑜𝑠𝑡 𝑆𝑙𝑜𝑝𝑒 𝑥 𝑇𝑜𝑡𝑎𝑙 𝐶𝑟𝑎𝑠ℎ 
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2) Menghitung biaya langsung 
Biaya Langsung = Biaya Langsung Normal + Kumulatif Tambahan  Biaya. 

e. Microsoft Project 2016 
Microsoft Project 2016 merupakan sistem proyek perangkat lunak manajemen yang 
dikembangkan dan dijual oleh Microsoft, yang dirancang untuk membantu manajer proyek dalam 
mengembangkan rencana, menetapkan sumberdaya untuk tugas-tugas, pelacakan kemajuan, 
mengelola anggaran, dan menganalisis beban kerja. Jadwal dapat menjadi sumberdaya diratakan, 
dan jaringan tugas yang divisualisasikan dalam grafik Gantt [19]. 

 

2. METODE PENELITIAN 
Suatu penelitian harus dilaksanakan secara sistematis dan dengan urutan yang jelas serta 

teratur, sehingga akan diperoleh hasil yang sesuai dengan apa yang diharapkan. Karena itu, 
pelaksanaan penelitian ini dibagi dalam beberapa tahapan-tahapan, diantaranya sebagai berikut 
[15]: 
a. Tahap I 

Tahap pertama, persiapan yaitu tahapan dimana penulis sebelum melakukan penelitian perlu 
adanya studi literatur untuk memperdalam ilmu yang berkaitan dengan topik penelitian. 
Kemudian ditentukan rumusan masalah sampai dengan kompilasi data. 

b. Tahap II 
Tahap kedua, pengumpulan data dalam hal ini adalah data proyek yang diperlukan untuk 
pembuatan laporan meliputi: Rencana Anggaran Biaya (RAB), Analisis Harga Satuan Pekerjaan 
(AHSP), Harga Satuan Bahan dan Tenaga Kerja, Time Schedule. 

c. Tahap III 
Pada tahapan ketiga, berupa kesimpulan untuk mengambil keputusan. Pada tahap ini, data yang 
telah dianalisis dibuat suatu kesimpulan serta saran   yang berhubungan dengan tujuan penelitian. 

 
Metode Analisis Data 

Setelah dilakukan penelitian dan data yang dibutuhkan sudah terkumpul, langkah selanjutnya 
adalah melakukan percepatan terhadap waktu dengan   melakukan penambahan jam kerja (lembur), 
sehingga produktivitas tenaga  kerja menjadi meningkat [20]. Untuk itu dilakukan analisis data 
dengan Microsoft Project 2016 untuk mendapatkan lintasan kritis yang kemudian akan diolah. 
Adapun penerapan time cost trade off, maka perlu dilakukan langkah- langkah sebagai berikut: 
a. Menyusun rencana jadwal dan biaya proyek (baseline). 

Langkah-langkahnya sebagai berikut: 
1) Memulai lembar kerja baru. 

     Klik Start > Program > Microsoft Project 2016. 
2) Masukkan tanggal mulainya pada proyek. 

     Klik menu Project > Change Working Time. 
3) Menentukan kalender kerja untuk mengetahui hari kerja, jam  kerja dan hari libur. 

Memilih menu File > Opion > Schedule. 

Klik tab week start. Klik Monday. 
Memilih menu File > Details > Set Day (S) to These    Spicific Woeking Times. 
Mengisi default start time dan default end time. 

b. Menyusun data kegiatan proyek dengan mengisi jenis kegiatan pada kolom Task Name dan waktu 
kegiatan pada kolom Durasi. Kemudian setelah kolom durasi diisi, kolom start dan finish akan 
terisi secara otomatis. 

c. Memasukkan hubungan antara pekerjaan satu dengan lainnya pada kolom Predecessor. 
d. Menerapkan metode time cost trade off. 
e. Penelitian ini dilakukan dengan menambahkan jam kerja (lembur) selama 2jam, 4jam dan 6jam 

untuk mempercepat penyelesaian durasi proyek hanya pada lintasan kritis yang telah didapatkan. 
 

Bagan Alur Penelitian 

Bagan alur penelitian dibuat untuk memahami bagaimana sebuah penelitian dilakukan dan apa yang 
dapat diharapkan dalam hal temuan dan kontribusi terhadap pengetahuan yang ada. 
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Gambar 2. Bagan Alur Penelitian 

3. HASIL DAN PEMBAHASAN 
Critical Task  

Dari data yang sudah dianalisis tersebut, maka diperoleh critical task/Kegiatan Kritis 
dibagian pekerjaan tertentu dengan menggunakan bantuan software Microsoft Office Project 2016. 
Berikut adalah critical task yang telah didapatkan: 

 

Tabel 2. Item Kegiatan Kritis 
 

Task Name Duration Start Finish Predecessors 
Free 
Slack 

Total 
Slack 

Critical 

Pekerjaan Pengecatan        
Mengecat Interior ex. Dulux ICI 28 days Tue 08/08/23 Fri 08/09/23 179SS 0 days 0 days Yes 
Mengecat Plafond ex. Dulux ICI 28 days Tue 08/08/23 Fri 08/09/23 179SS 0 days 0 days Yes 
Mengecat Beton + Compound 
(Tangga & Topi-topi) 

28 days Tue 08/08/23 Fri 08/09/23 179SS 0 days 0 days Yes 

Mengecat Conwood  
ex. Propan Fibercote 

28 days Tue 08/08/23 Fri 08/09/23 179SS 0 days 0 days Yes 

Pekerjaan Pagar, Kanopi, Dll        
Pekerjaan Vegetasi 14 days Thu 24/08/23 Fri 08/09/23 222 0 days 0 days Yes 
Pekerjaan Lain-lain 14 days Thu 24/08/23 Fri 08/09/23 222 0 days 0 days Yes 

                  Sumber: Hasil olah data Ms. Project 2016. 
 

Durasi Proyek 
Durasi pada pekerjaan Proyek Pembangunan Rumah Tinggal Jalan Salak No. 70 ini adalah tanggal 12 
Desember 2022 sampai dengan 8 September 2023 dalam kurun waktu 38 minggu atau 233 hari 

Mulai 

Studi Lapangan & Studi 
Pustaka 

Menentukan Latar Belakang Masalah 
Pustaka 

Identidikasi dan Perumusan Masalah 
Pustaka 

Data Sekunder: 
1. Rencana Anggaran Biaya (RAB) 
2. Daftar harga satuan upah 
3. Analisis harga satuan pekerjaan 
4. Time Schedule 

Data Sekunder: 
1. Durasi dipercepat 
2. Tambahan biaya 

 

Analisis Time Cost Trade Off 

Kesimpulan dan 
Saran 

Selesai 
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kalender sesuai dengan schedule kontrak (perjanjian kerja). Dimana pada setiap minggunya terdapat 
6 hari kerja, dengan setiap 1 hari nya adalah 8 jam kerja dari jam 08.00 – 17.00 WIB. 

 

Biaya Proyek 
Adapun rincian biaya pada Proyek Pembangunan Rumah Tinggal Jalan Salak No. 70 ini dapat dilihat 
pada tabel di bawah. 

Tabel 3. Rincian Rekapitulasi Pekerjaan 
 

No. Uraian Pekerjaan Harga 
I Pekerjaan Persiapan Rp 22.602.500,00 
II Pekerjaan Tanah Dan Pondasi Rp 231.079.529,63 
III Pekerjaan Pasangan Dinding Rp 497.625.700,00 
IV Pekerjaan Beton Rp 878.755.116,30 
V Pekerjaan Penutup Atap Rp 352.745.303,00 
VI Pekerjaan Langit-Langit Rp 95.745.500,00 
VII Pekerjaan Sanitasi Rp 342.887.450,00 
VIII Pekerjaan Kayu Dan Besi Rp 320.244.538,00 
IX Pekerjaan Penutup Lantai & Dinding Rp 471.654.550,00 
X Pekerjaan Pengecatan Rp 139.038.550,00 
XI Pekerjaan Listrik Rp 176.536.000,00 
XII Pekerjaan Pagar, Kanopi & Carport Rp 265.393.938,92 
XIV. Pekerjaan Kolam Renang Rp - 
Jumlah Rp 3.794.308.675,84 
Jasa Kontraktor Rp 206.000.000,00 
Jumlah Total Rp 4.000.308.675,84 
Jumlah Dibulatkan Rp 4.000.000.000,00 

                Sumber: RAB Proyek Pembangunan Rumah Tinggal Jalan Salak No. 70 
 

Perhitungan 2 Jam Lembur 
Berikut hasil perhitungan produktifitas harian, produktifitas per jam, produktifitas harian setelah 
dilakukan Crash, dan Crash Duration untuk 2 jam lembur. 
 

Tabel 4. Crash Duration untuk 2 Jam Lembur 
 

2 Jam Lembur 
 
No 

 
Uraian 
Pekerjaan 

 
Sat. 

 
Volume 

Durasi 
(Hari 
kerja) 

Prod. 
Harian 

Prod.  
Per jam 

Prod. 
Lembur 

Prod. Harian 
Setelah Crash 

Crash  
Duration 

X Pekerjaan 
Pengecatan 

        

1 Mengecat Interior 
ex. Dulux ICI 

m2 955,58 28 34,1278 4,2659 6,8254 40,9529 23 

2 Mengecat Plafond 
ex. Dulux ICI 

m2 404,65 28 14,4518 1,8065 2,8904 17,3421 23 

3 Mengecat Beton + 
Compound 
(Tangga & Topi-
topi) 

m2 23,13 28 0,8261 0,1033 0,1652 0,9913 23 

4 Mengecat 
Conwood ex. 
Propan Fibercote 

m2 108,54 28 3,8764 0,4846 0,7753 4,6517 23 

XII Pekerjaan Pagar, 
Kanopi, Dll 

        

1 Pekerjaan 
Vegetasi 

m2 59,2 14 4,2286 0,5286 0,8457 5,0743 12 

2 Pekerjaan Lain-
lain (Cleaning 
Bangunan) 

m2 507 14 36,2143 4,5268 7,2429 43,4571 12 

       Sumber: olah data Ms. Excel. 
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Berdasarkan tabel hasil perhitungan dari Crash Duration untuk 2 jam lembur perubahan waktu 
normal dari akibat percepatan dari tiap-tiap pekerjaan adalah sebesar 23; 23; 23; 23; 12; dan 12 hari 
kerja. 

 
Analisis Pertukaran Waktu dan Biaya (Time Cost Trade Off) 
Setelah diperoleh nilai Cost Slope dari masing-masing kegiatan, maka  langkah selanjutnya adalah 
dilakukan penekanan (kompresi) durasi proyek pada setiap kegiatan di lintasan kritis yang dapat 
dilihat pada tabel 5. Penekanan (kompresi) durasi proyek dimulai dari aktivitas yang mempunyai 
cost slope (penambahan biaya akibat percepatan)  terendah.  

 

Tabel 5. Total Durasi Proyek Setelah Crashing untuk 2 Jam Lembur 
 

Total Durasi 2 Jam Lembur 

No. Uraian Pekerjaan 
Normal 
Duration 
(HK) 

Crash 
Duration 
(HK) 

Total 
Crash 
(HK) 

Total 
Duration 
(HK) 

 Normal Durasi    233 
X Pekerjaan Pengecatan         
1 Mengecat Interior ex. Dulux ICI 28 23 5 228 
2 Mengecat Plafond ex. Dulux ICI 28 23 5 223 
3 Mengecat Beton + Compound (Tangga & Topi-topi) 28 23 5 218 
4 Mengecat Conwood ex. Propan Fibercote 28 23 5 213 
XII Pekerjaan Pagar, Kanopi, Dll         
1 Pekerjaan Vegetasi 14 12 2 211 
2 Pekerjaan Lain-lain (Cleaning Bangunan) 14 12 2 209 

  Sumber: olah data Ms. Excel. 
 
Berikut akan diuraikan proses hitungan tahap kompresi dengan alternatif penambahan jam kerja 
(lembur) optimum dengan durasi crahing. Proses ini merupakan bagian penting dari manajemen 
proyek yang membantu proyek tetap sesuai dengan tenggat waktu yang ditentukan atau bahkan 
lebih cepat. Namun, perlu diingat bahwa penggunaan lembur harus dikelola dengan bijak, karena 
penambahan jam kerja yang berlebihan dapat mengakibatkan kelelahan pekerja, biaya tambahan 
yang tinggi, atau bahkan penurunan kualitas pekerjaan. 
Tahap Normal 
Durasi normal   = 233 hari 
Biaya langsung   = Rp 3.794.308.675 
Dibulatkan    = Rp 3.794.000.000 
Biaya tidak langsung = 5% biaya langsung = Rp 189.500.000 
Total biaya normal   = Biaya langsung + Biaya tidak langsung 

  = Rp 3.794.000.000 + Rp 189.500.000 
  = Rp 3.983.500.000 

Tahap Kompresi dengan durasi crashing 2 jam lembur 
Crashing pekerjaan pengecatan interior: 
Cost slope /hari   = Rp. 793.500 
Durasi normal pekerjaan = 28 hari 
Durasi dipercepat   = 23 hari 
Crashing    = 5 hari 
Total durasi normal   = 233 hari 
Total durasi crash   = 228 hari 
Tambahan biaya   = Rp. 793.500 x 5 hari = Rp 3.967.500 
Biaya langsung   = Rp 3.794.000.000 + Rp 3.967.500 = Rp 3.797.967.500 
Biaya tidak langsung = 5% x Rp 3.797.967.500 = Rp 189.898.375 
Total biaya crash   = Rp 3.797.967.500+ Rp 189.898.375 = Rp 3.987.865.875 
Hasil pengkompresian (penekanan) terhadap waktu dan biaya dapat dilihat pada tabel berikut. 
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Tabel 6. Kompresi Waktu dan Biaya Setelah Tambahan 2 Jam Lembur  
 

No Uraian Pekerjaan 
Total 

Duration 
(HK) 

Tambahan 
Biaya 

Biaya 
Langsung 

Biaya Tidak 
Langsung 

Total Biaya 

Kondisi Normal 233 
 

3.794.000.000 189.500.000,00 3.983.500.000,00 
X Pekerjaan Pengecatan 

     

1 Mengecat Interior ex. Dulux ICI 228 3.967.500,00 3.797.967.500 189.898.375,00 3.987.865.875,00 
2 Mengecat Plafond ex. Dulux ICI 228 3.967.500,00 3.797.967.500 189.898.375,00 3.987.865.875,00 
3 Mengecat Beton + Compound 

(Tangga & Topi-topi) 
228 3.967.500,00 3.797.967.500 189.898.375,00 3.987.865.875,00 

4 Mengecat Conwood ex. Propan 
Fibercote 

228 3.967.500,00 3.797.967.500 189.898.375,00 3.987.865.875,00 

XII Pekerjaan Pagar, Kanopi, Dll 
     

1 Pekerjaan Vegetasi 231 2.070.000,00 3.796.070.000 189.803.500,00 3.985.873.500,00 
2 Pekerjaan Lain-lain (Cleaning 

Bangunan) 
231 2.070.000,00 3.796.070.000 189.803.500,00 3.985.873.500,00 

Sumber: olah data Ms. Excel. 
 

Berdasarkan tabel hasil perhitungan biaya langsung (direct cost) untuk 2 jam lembur dimana 
pekerjaan pengecatan interior dengan cost slope terendah. Kemudian dilakukan tahap 
mempersingkat waktu pada tahap normal 233 hari dipersingkat 5 hari menjadi 228 hari dengan 
perubahan biaya langsung menjadi Rp. 3.797.967.500 dan biaya tidak langsung menjadi Rp. 
189.898.375 sehingga didapatkan biaya total sebesar Rp. 3.987.865.875. Pada tabel 4.7 diatas yang 
dimana didapatkan dengan biaya paling minimum yaitu pada pekerjaan tahap akhir dengan total 
durasi 231 hari yang berarti lebih cepat 2 hari dari waktu normal yaitu 233 hari, kemudian didapat 
total cost sebesar Rp. 3.985.873.500 yang berarti ada penambahan biaya sebesar Rp. 2.373.500 dari 
biaya normal Rp. 3.983.500.000. 
 
Perhitungan Jam Lembur dan Efisiensi 
a. Untuk alternatif penambahan 2 jam kerja (lembur) dengan jumlah durasi dipercepat = 2 hari kerja 

dan total biaya = Rp. 3.985.873.500 
b. Dengan efisiensi waktu dan biaya sebagai berikut: 

1) Efisiensi waktu proyek:  
233 – 231 = 2hari   atau, ((233 –  231))/233 𝑥 100% = 0,8584% 

2) Efisiensi biaya proyek: 
Rp. 3.983.500.000 – Rp. 3.985.873.500 = Rp. 2.373.500 
3.983.500.000 − 3.965.987.000 𝑥 100% = 0,0596% 

                 3.983.500.000 
 

4. SIMPULAN  
Berdasarkan hasil analisis percepatan waktu dan biaya konstruksi dengan penambahan jam 

kerja (lembur) menggunakan metode time cost trade off pada proyek pembangunan rumah tinggal 
jalan Salak No. 70 yang berpusatkan pada batasan masalah pekerjaan kritis, maka dapat diambil 
kesimpulan bahwa jumlah durasi yang dapat dipercepat yang diperoleh pada setiap penambahan 
jam kerja bahwa untuk penambahan 2 jam kerja (lembur) dimana diperoleh dari biaya paling 
minimum pada pekerjaan kritis dengan total durasi 231 hari yang berarti lebih cepat 2 hari dari 
waktu normal yaitu 233 hari. Efisiensi waktu pekerjaan sebesar 0,8584%. Untuk penambahan 4 jam 
kerja (lembur) dimana diperoleh dari biaya paling minimum pada pekerjaan kritis dengan total 
durasi 230 hari yang berarti lebih cepat 3 hari dari waktu normal yaitu 233 hari. Efisiensi waktu 
pekerjaan sebesar 1,2876%. Untuk penambahan 6 jam kerja (lembur) dimana diperoleh dari biaya 
paling minimum pada pekerjaan kritis dengan total durasi 229 hari yang berarti lebih cepat 4 hari 
dari waktu normal yaitu 233 hari. Efisiensi waktu pekerjaan sebesar 1,7167%. Jadi dari setiap 
masing-masing penambahan jam lembur (2 jam, 4 jam, 6 jam) diperoleh selisih percepatan yaitu 1 
hari pada setiap penambahan jam lembur. Tambahan biaya yang dapat diperoleh pada setiap 
penambahan jam kerja bahwa untuk penambahan 2 jam kerja (lembur) terjadi penambahan biaya 
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dari Rp. 3.983.500.000 menjadi Rp. 3.985.873.500 atau terjadi penambahan sebesar Rp. 2.373.500 
dengan efisiensi biaya sebesar 0,0596% per 1 (satu) orang pekerja. Untuk penambahan 4 jam kerja 
(lembur) terjadi penambahan biaya dari Rp. 3.983.500.000 menjadi Rp. 3.983.500.000 atau terjadi 
penambahan sebesar Rp. 2.885.375 dengan efisiensi biaya sebesar 0,0724% per 1 (satu) orang 
pekerja. Untuk penambahan 6 jam kerja (lembur) terjadi penambahan biaya dari Rp. 3.983.500.000 
menjadi Rp. 3.986.298.750 atau terjadi penambahan sebesar Rp. 2.798.750 dengan efisiensi biaya 
sebesar 0,0703% per 1 (satu) orang pekerja. Berdasarkan penelitian di atas penambahan jam lembur 
yang dilakukan selama 2 jam sangatlah efisien daripada melakukan lembur 4 dan 6 jam. 

 
Saran 

Kegiatan lembur sebaiknya dilakukan jika pada kegiatan-kegiatan yang bersifat urgent atau 
pada lintasan kritis. Percepatan penyelesaian durasi proyek dengan alternatif penambahan jam kerja 
(lembur), merupakan salah satu alternatif bagi pihak perusahaan khusunya kontraktor untuk 
mendapatkan durasi proyek tercepat sebagai bentuk efesiensi waktu. Selain alternatif penambahan 
jam kerja (lembur) dapat dicoba juga alternatif  lain seperti penambahan tenaga kerja, penambahan 
alat, dan metode lainnya. 
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